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Installing and Running the Scripts

Installation
The scripts can be run separately or as the panels inside After Effects.
To use scripts as panels, first copy the scripts into the After Effects ScriptUI  Panels directory:
On Windows:
 C:\Program Files\Adobe\Adobe After Effects <version>\Support Files\Scripts\ScriptUI Panels\
On OS X:
 MacHD/Applications/Adobe After Effects <version>/Scripts/ScriptUI Panels/

Running the Scripts
To run a stand-alone script, choose File > Script > Run Script and navigate to the folder where your 
script is located.
Open a script as a panel, copy the scripts to the After Effects ScriptUI Panels directory, and choose 
Window > Conform Studio.jsx or any other script from the list. Any Conform Studio script can be 
opened as a panel.

Compatibility
Conform Studio scripts were tested on CS6 and CC, but it’s possible that they will run on the earlier 
versions, starting with CS3 as well. You will not be able to invoke stand-alone scripts before CS5.5 
though, as the distributed files are of jsxbin type, and the option to run jsxbin files via File > Script > 
Run Script was added in CS5.5. 
If you find the scripts not compatible with the AE version you are running, contact me at 
bart@creativeimpatience.com.

Troubleshooting
If you experience problems running the scripts, please use the aescripts + aeplugins forum and support 
system. This is the best and the surest way to receive the needed support.

mailto:bart%40creativeimpatience.com?subject=Conform%20Studio%20-%20Troubleshooting
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Conform Studio Launch Panel

Conform Studio Launch Panel is a simple panel which sole purpose is to run other Conform Studio 
scripts. 
To run any script simply click the button with script’s name. The script will open as a dialog.
If you want to run a script as a panel, you need to choose it from the Window menu.
To dock the Conform Studio Launch Panel, simply grab the gripper in the upper-left corner of a 
panel’s tab and drag it into the desired drop zone. The panel was designed to fit neatly into the space 
where usually the Info panel is located, but you can put it anywhere you want.
Note: All Conform Studio scripts must be placed in the same directory as the Conform Studio 
Launch Panel script for it to work correctly.
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CS Conform

CS Conform will automatically precompose non-overlapping layers in your composition into separate 
compositions, batch rename them according to selected presets, and apply handles. It also offers 
several useful advanced options, and a possibility to insert shots into already conformed composition.

Target
CS Conform requires a single composition to be selected. It will work on all audio and video layers in 
your composition. 

How It Works
The script iterates from top to bottom, so you need to have your layers sorted in such a way that the 
layers beginning earlier need to be higher in the composition. Otherwise the script might become 
confused, and the results might not be what you expect. You can use the standard “Sort Layers by In 
Point” script that is distributed with After Effects, to sort your layers.
By default, all overlapping layers are going to be precomposed into their own composition, and if the 
consecutive layers share the same name, they will also be placed into a single composition. Any Guide 
Layer is going to be skipped.
To include Guide Layers in the process, uncheck the “Skip Guide Layers” option (on by default).
To group overlapping layers into separate compositions, uncheck the “Group overlapping layers” 
option (on by default).
To avoid gouping layers with the same name, uncheck the “Group consecutive layers with the same 
name” option in the Advanced tab.
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Sometimes After Effects thinks layers are overlapping, even if they seemingly aren’t. If you encounter 
such behavior, you can increase the “Overlap margin” value to virtually shorten the layers for the 
purposes of overlap calculation. The default value of 0.001 second should be enough for most cases.
Depending on the value of “Inherit timecode” option, the precompositions will start at either 
00:00:00:00 or at a value equal to the timecode of the topmost, or the bottom layer. 
For single layer precomps, the time remapping, time stretch and other effects and attributes will be 
left in the original composition or transferred to the precomposition depending on the value of the 
“Leave attributes when precomposing single layers”.
After precomposing, the compositions will be named using the selected naming scheme and placed 
in the folder selected with the “Destination folder” text field. If such a folder is not present, it will be 
created in the parent folder of the selected composition.

Naming Schemes
The script allows you to create a naming scheme preset of your own, and save it as a preset. 
Preset List gives you the list of all presets installed on your system. After choosing any preset, the 
remaining fields are going to be changed accordingly.
Reset button will activate if any of the fields are changed, and will return their values to the ones 
saved with the preset, when pressed.
Save button will also activate if any of the fields are changed, and will save the new values as a new 
preset.
Delete button is active if more than one preset is present. Pressing it will remove the currently 
selected preset, and choose the next one from the list.
Prefix text field contains the part of the name which remains unchanged. By pressing the << button to 
its right you will copy the name of any currently selected item in the project panel.
Start is the initial number that will be placed after the prefix.
Step is the amount that the initial number is going to increase with each composition. Depending 
on your workflow, you might want to put it at greater than 1, so that if you happen to later add shots, 
you can simply fill in the empty places instead of renaming everything or creating strange names and 
numbers.
Padding sets the total number of digits that the shot number will contain. For example, if you have 
100 shots that will start with the value of 10, and step by 10, you want to have the padding of 4, since 
the very last shot (1000) will have 4 digits in total. This is useful for sorting. 
Suffix is the text that is going to be added to each name at the very end. 
Name shows the name of the first composition that is going to be created.

Insert New Shots Into Existing Composition
If you have a composition that was already conformed, and you need to make changes by adding shots 
between other shots, simply insert the appropriate layers, make sure they are sorted by in-point, and 
then check this option. The script will then precompose only the new layers, and assign new numbers 
according to the sequence. This is where having enough free numbers between the shots comes in 
handy. If the script can’t find a free number, the layer will not be precomposed. 
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Destination Folder
By default, the precompositions will be placed in the shots folder that is going to be created in the 
parent folder of the selected composition. You can name it differently by typing another name in the 
text field, or point the script to the already existing folder by selecting it and clicking on the << button 
to the right of the text field. Note, that if the button is not used, the script will look for the folder 
name in the project structure, and will settle on the first it finds, so simply typing the name of an 
existing folder might not work.

Handles
You can add handles to your compositions in case you want to have some wiggle room to play with 
later, after the compositions are done. The amount can be selected in the text box next to the “Add 
handles” option. This field will only become active, if the “Add handles” checkbox is turned on.
Handles are calculated on the composition level, and are not dependent on any time remapping or 
time stretch values of the layers contained within. Layers which do not touch the in or out point of the 
composition will not be extended to be included in the added ranges.

Target Composition
The changes by default will be made to a duplicated composition, and the suffix _conformed will 
be added to its name. If you want to change it, modify the text field next to the “Duplicate original 
comp, add suffix” option. This field will only be active, if the checkbox is turned on. If you want the 
changes to be applied to a selected composition, uncheck the “Duplicate original comp” option. 
In general, it is advisable to leave this option on. 

Inherit Labels
If you want your compositions to retain the layer labels, check the “Inherit labels” option in the 
Advanced tab. The compositions will use the label of the first layer contained therein.

Inherit Timecode
With this option disabled, each precomposition will start at 00:00:00:00. When enabled, the starting 
timecode will be obtained from the bottom layer in the composition by default. You can select the 
topmost layer from the dropdown menu. 

Leave Attributes For Single Layers
By default, all layer properties and effects, including layer Time Stretch and Time Remapping are 
moved into the new compositions. Therefore all compositions in the main composition will be set 
at 100%. If you want to leave these attributes in the main composition, it is only possible for single 
layers, and you can do it by turning the “Leave attributes when precomposing single layers” on. 
When this option is turned on, all single layers will be precomposed as if the “Leave attributes” 
option was selected in the standard precompose dialog (the one that appears when you select Layer > 
Precompose). The length and handles will be adjusted in either case. 
This option has no relevance to the precompositions containing more than 1 layer as determined by 
any of the grouping options.
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Layer Time Stretch and Time Remapping
If you want to enable a certain type of frame blending for these layers, move into the Advanced tab, 
and check “Enable Frame Blend for time-stretched layers”. The dropdown list below will become 
active, and you will be able to choose the kind of frame blending you want. The frame blending will 
be applied automatically to all time-stretched or time remapped layers, and the Frame Blending 
switch will be turned on for each composition containing at least one affected layer.

Saving The Settings
Pressing “Save as default” will save all the advanced settings, alongside with the handles option in 
the Options tab. Next time you run the script, these settings will be loaded for you. 

Importing and Exporting Naming Presets
If you want to share the naming presets that you create, or simply import presets that you created 
in some other way, use the buttons “Import preset file” and “Export preset file” in the Preset 
management group in the Advanced tab. 
Import preset file will overwrite any presets currently residing on your system, if the file turns out to 
be valid. 
Export preset file will export a csv (comma separated value) file containing all the presets installed on 
your system. It’s a simple text file that is structured like this:
 prefix,start,step,padding,suffix
You can create valid preset files by yourself. The script validates the file before importing, and will 
only import properly formatted files.

Troubleshooting
If your layers seem to be thrown together even though they seemingly are not overlapping, increase 
the “Overlap margin” parameter in the Advanced tab.
If the precomposition frame rate is different than the layer’s frame rate, and you choose to “Inherit 
timecode”, the composition starting timecode at higher values might be shifted by one frame due to 
rounding errors and inexact math of non-integer timecodes implemented in After Effects.
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CS Extract

Trim and Extract, or CS Extract, will allow you to extract multiple compositions to separate files, 
with the possibility to manage your media, including not only collecting the files, but also trimming 
them. Advanced processing will allow you to move your footage and compositions to desired folders 
and run scripts to further prepare your compositions and projects.

Target
Select a folder containing compositions or a number of compositions to be exported. If you have a 
hierarchical structure with several subfolders and want to traverse all of them, make sure to turn on 
the “Search selection recursively” checkbox.

How It Works
The script iterates through the selected compositions, and for each it reduces the project, so that only 
this single composition is present along with used media, and then saves the file to the destination 
directory. If “Collect files” option is chosen, the files are collected to a subfolder, and if “Trim 
footage” is selected, all footage is trimmed using the options found in the Trim settings tab.
If media is trimmed, then the selected render settings are applied, and the media contained within 
the project are trimmed and transcoded to the length of composition plus optionally the amount of 
handles specified in the “Add handles” text box. 
If “Consolidate gaps” option is selected, a single file will be output for multiple layers using the same 
media within the specified span. If the gaps are longer than the selected value (5 seconds by default), 
separate files will be created for those.
If layers are time-stretched or contain Time Remapping, the range will be calculated before these 
effects are applied, and the trimming will occur on the original media. The media will not be 
changed in any way - all effects, including Time Remapping and Time Stretch will be applied in the 
composition, not to the trimmed media.
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Handles are calculated on based on the original media frame rate. It means that the layer at 50% will 
still contain 12 frames of handles (assuming the default value), allowing only 6 frames of the wiggle 
room in the composition. 
All keyframes will be copied and properly transposed. Their location and values will not change. The 
only exception is Time Remapping, which will be adjusted to reflect the time range of the trimmed file. 
We strived to make your projects the same as originals, but there are two issues that you might 
encounter during trimming which are independent of our work. See the Troubleshooting part if this 
user guide.  
When “Advanced processing” is enabled, the script will perform the operations specified in the 
“Processing” tab – move extracted composition into selected folder, move footage into selected folder, 
execute custom project-wide scripts, and then finally execute the custom script which targets the 
extracted composition. 
Elements are moved during the project reduce stage, and the scripts are executed right afterwards, 
before trimming or collect. 

Basic options
Browse button will allow you to navigate to a directory where you wish your compositions to be 
extracted to.
Search selection recursively will force the script to traverse subfolders if you selected a folder 
containing compositions in the project panel.
Extract comps into separate directories will save each composition to their own folder named after 
the composition. 
Enable advanced processing will enable access to the “Processing” tab and perform operations 
specified therein during extraction. See Advanced processing for details.

Media Management
Do nothing will only save After Effects projects into designated destination directory.
Collect files will perform File > Dependencies > Collect Files… for each extracted composition.
Trim footage will activate the Trim options tab and perform media trimming for each extracted 
composition.

Trimming Options
The Trimming options tab contains the list of render presets and encoding templates available at the 
time the script was run. If you added new presets after opening this panel, you need to restart the 
script to make them visible. 
There are separate render settings for the files with and without the alpha channel. For example, you 
might want to use ProRes422 HQ for the files without the alpha channel, and ProRes 4444 when the 
alpha channel is present. When you are creating presets for alpha channel export, make sure to include 
the “RGB + Alpha” in your “Channels” setting!
Add handles option will allow you to add a specified amount of handles to each media layer. Note, 
that the handles are calculated on the media frame rate, and time-stretched layers will not contain 
lesser or larger amound of handles.
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Leave original media in trimmed project will not remove the original layer from the project. This 
way, if you are suspicious about script’s accuracy, you can double-check yourself, and later simply 
delete the layer. The original media is not going to be copied into the trimmed directory.
Consolidate gaps will output a single media file for all instances that are not separated from each 
other for more than the specified number of seconds. Otherwise each instance will export a single file.
Save as defaults will save your selection as a default to be available next time you open the script.

Advanced Processing (Processing Tab)
This tab is enabled when Enable advanced processing option is checked in the “Options” tab.
Move comps to folder checkbox will cause the extracted composition to be moved to the folder 
specified in the textbox below. 
There are two ways to specify the folder. You can enter its name or even the path towards it manually, 
for example: comps will move the composition to the comps folder in the project root, and comps/
main will move it to the main folder in the comps folder in the project root. Alternatively you can 
select a folder in the project panel and then press the << button. The path to the folder will be saved in 
the textbox. 
The script always makes sure that the whole path toward the selected folder is created. Note, that 
when the Move comps to folder checkbox is turned off, the move will not happen, even if you specify 
the folder path.
Similarly, Move footage to folder will cause all footage in the reduced project to be moved to the 
specified folder. 
Project scripts is a list displaying names of the scripts that will run right after the project is reduced, 
and the comps and footage is moved. These scripts must not rely on anything being selected or active. 
Usually they will create a folder structure, establish project bit depth, etc. The scripts will be executed 
in the order they are placed on the list. There is no limit on the number of scripts that can be added. 
To add a script, click the + (plus) button to the right of the list. A dialog will open asking you to find 
the jsx or jsxbin file. No other files are accepted. To remove a script, select it from the list, and then 
click the activated - (minus) button to the right of the list. 
Similarly, Composition scripts is a list displaying scripts that will run after all project scripts have 
executed, and will target the extracted composition. These scripts can for example setup default effects 
or layers or further process footage layers present in the composition. Before these scripts are being 
run, the extracted composition is made active (app.project.activeItem). 
You can add and remove the composition scripts using the + (plus) and - (minus) buttons to the right 
of the list. 
Save as defaults will save the options to a file, and then each time you open the script, these options 
will be present. It only saves the options from the Processing tab. 
Note, that the folder paths are not checked when loading options, but the scripts paths are. If any of 
your scripts is not present on the system, it will not be loaded into the list. 

Troubleshooting
You might experience two issues using this script. One is the timecode shift, another is a subframe 
variation for time-stretched layers.
Timecode shift will occur randomly in the media that has the starting timecode larger than roughly 
09:00:00:00. You might experience a shift by one or two (if the starting timecode is higher than 19 
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hrs) frames. For example, the original layer will read 16:57:06:11, but the rendered layer will read 
16:57:06:12 on the same frame. This is unfortunately an After Effects bug, and there is nothing we 
can do do fix it - the ball is in Adobe’s court on this one. Note, that this will only be present in the 
video files, and the image sequences are not affected by it. If this is a deal-breaker for you, use image 
sequences. 
The layers will be perfectly aligned, it is only the timecode value that will be different. 
The subframe variation for time-stretched layers might occur when the layer is time-stretched, and 
the trimming occurs on the frame that should have a fractional frame value. Unfortunately, this is 
pretty common, and this version of the script does not have the option to intelligently trim the layers 
to make sure that the Time Stretch is perfectly aligned. The variations will however maximally reach 
half a frame. For most purposes this difference is going to be negligible. 
Please use “Leave original media in trimmed project” option if you are uncertain if the automatic 
alignment is correct. You can later remove the original layer after you check the result.
Note, that even though this script can theoretically be used as a way to trim and archive your projects, 
we have not tested it towards this end, and advise extreme caution if you choose to do so.
If you find any of these issues being a show-stopper, email me at bart@creativeimpatience.com.

mailto:bart%40creativeimpatience.com?subject=Conform%20Studio%20-%20Troubleshooting
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CS Reconform
CS Reconform will allow you to replace your 
compositions with rendered files, update these files 
to the latest versions, or simply replace them with 
files from another directory. 

Target
Select a composition or a number of layers in the 
composition. Note, that if any layers are selected in 
the selected composition, only these will be affected, 
so if you want to affect all layers, deselect them!
To replace with rendered layers you need to select 
comp layers, for the two other options to work you 
need to select video layers.

How It Works
The script iterates the selected layers, and looks for 
the files with a given name core in a given directory 
and its subdirectories, and matches shots by the 
number following the core name. 
If the “Look for the highest version number” 
option is checked, it’s going to find the files with 
the highest version number at the very end of the 
filename. Otherwise the first found file is going to 
be imported. 
If the “Look for image sequences” option is checked, the script is going to look for the folders named 
like the compositions, and will assume that each folder contains only a single render, regardless of the 
filename within. 
The files are going to be imported into the selected folder, and will replace the selected compositions 
(“Replace with rendered files”) or video layers (the two other options). Note that the replacement is 
based on the layer start, not on the timecode. The length of the layers does not have to match.
The changes will be made either in the active composition or in its clone which name will be modified 
to include the suffix. 

Reconform Options
Replace with rendered files will target composition layers in the selected composition, and replace 
those with matching files. 
Update renders to the latest version will replace the video layers with files that have the same core 
name, number, and the highest version number at the very end of the file. Make sure to use it with the 
option to “Look for the highest version number” turned on.
Replace renders from another directory will look for the same file names in another directory, 
import these into the selected folder, and replace the affected layers with the newly imported files. It 
does not replace the source for previously imported media.
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Import Folder
By default, the files will be imported to the render folder that is going to be created in the project 
root folder. You can name it differently by typing another name in the text field, or point the script to 
the already existing folder by selecting it and clicking on the << button to the right of the text field. 
Simply typing the name of an existing folder might not work.

Name Core
Name core is equivalent to the “Prefix” set in the naming presets in CS Conform. It’s the unchanging 
part of the file name that defines the files that the script is looking for. What follows the name core is 
the shot number (“Shot” in CS Conform), and this is the unique identifier of the composition. 
To create the name core you can either type it or paste it into the text field, or use the << button to the 
right of the field to obtain it from the selected layer. The first press of this button will copy the name 
into the field, and each successive click will remove the last found number and the trailing text. For 
example, if the selection is named “hp_trailer_vfx_S00150_bwalczak_00”, the successive clicking will 
result in the following sequence:
 (1) hp_trailer_vfx_S00150_bwalczak_00
 (2) hp_trailer_vfx_S00150_bwalczak_
 (3) hp_trailer_vfx_S
Additional clicks will have no effect.

Additional Options
Look for the highest version number will always look for all the files, and choose the one with the 
highest version number. Note, that the file can have an indeterminate text between the shot number, 
and the version number, and it is the version number that determines the primacy. The script assumes 
that the version number is the last thing before the extension. If there are any other characters 
afterwards, it is not going to work properly.
Look for image sequences is going to look for folders adhering to the naming scheme, and will 
import the image sequences contained within these folders. The filenames inside the folder do not 
matter apart from After Effects standard for image sequences - the image number must be the last 
thing in the filename. 
Ignore prefixes in the filename will ignore anything that comes before name core. It can be useful 
when replacing the renders with output from packages like Resolve, where the version and shot 
number is output at the beginning of the file. The script will disregard that, and only start looking 
after the name core. If this option is turned off, the filenames must begin with the name core.
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Final Remarks
Thank you for trying out or buying Conform Studio. We tried very hard to bring you the product 
that will make your life easier, and save you hours of menial work. If for some reason we had not 
succeeded, the surest and quickest way to obtain support is to use the support mechanism on 
aescripts+aeplugins website:

aescripts.com/contact/

Feedback
If you have some ideas that would make your life easier or you feel some features are missing, feel free 
to contact me at bart@creativeimpatience.com and we’ll be happy to hear your thoughts, and work 
towards a solution. 

http://aescripts.com/contact/
mailto:bart%40creativeimpatience.com?subject=Conform%20Studio%20-%20Development
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Change Log

1.5
Release date: Feb 2nd, 2020

New Features
General

• Added OS X Catalina compatibility
• Added CC 2020 compatibility
• Moved to a new licensing framework
• Settings are saved using the new licensing framework

1.3
Release date: Apr 9th, 2018

New Features
General

• Added CC 2018 compatibility.
• Changed branding

CS Reconform
• Will now look into subfolders for matched shots

Bug Fixes
CS Conform

• Presets file would not be parsed.
CS Extract

• Exporting to image sequence formats would fail.
CS Reconform

• Image sequences would not be imported properly
• Version numbers above 9 would not be compared correctly

1.2.5
Release date: Jan 15th, 2015

Bug Fixes
CS Extract

•  Dot in the filename would cause the rendered filename to be truncated to the first dot and 
prevent reimporting.
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1.2.4
Release date: Dec 16th, 2014

Bug Fixes
CS Conform

• Composition in and out points are now set properly if a layer is longer than the layers below it.

1.2.3
Release date: Nov 2nd, 2014

New Features
CS Conform

• An option to skip Guide Layers was added to the advanced options.

Bug Fixes
CS Conform

•  Sometimes overlapping layers did not get precomposed together when the “Group overlapping 
layers” option was turned on.

1.2.2
Release date: Oct 8th, 2014

Bug Fixes
CS Conform

•  The first layer was always extended to the beginning of the composition regardless of its starting 
point.

1.2.1
Release date: Jul 21st, 2014

New features
• Included sample scripts to use with the CS Extract

1.2
Release date: Jul 21st, 2014

New features
CS Conform

• Insert shots into already conformed composition
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CS Extract
• Enable advanced processing
• Specify composition destination folder
• Specify footage destination folder
• Run project scripts
• Run composition scripts
• Save processing defaults

Bug Fixes
CS Conform

• Fixed errors preventing opening as a panel
CS Extract

• Fixed error when saving presets file is impossible
CS Reconform

• Fixed launching ExtendScript Toolkit on reconform
• Fixed errors preventing opening as a panel

1.1
Release date: Jun 19th, 2014

New Features
 CS Conform

• Select destination folder
• Inherit timecode
• Leave attributes for single layers
• Save settings

Bug Fixes
Conform Studio Launch Panel

•  Fixed possible interference with other scripts
CS Conform

•  Improper calculation of maximum layers in certain cases
•  Frame Blend was applied regardless of the setting

1.o
Release date: Jun 9th, 2014
Initial release
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